
UNITIS Rt. Windchill PDMLink oktatóanyag 

  
     I N T E L L I G E N T     S O L U T I O N S  

 

 UNITIS Rendszerház Rt.  

 2040 Budaörs, Kinizsi u. 2/B 

 Kereskedelmi HOT-LINE: 23/50-50-70  

Support HOT-LINE: 23/50-50-60 
     Telefax: 23/50-50-71 

PDMLink ügyességek 
Pro/ENGINEER Wildfire 

környezetben 
 
 

 
 
 
 

 
 



 2 

TARTALOMJEGYZÉK 

 
BEVEZETŐ ................................................................................................................................................................... 3 
A TERVEZÉS MEGKÖNNYÍTÉSE PDMLINK-HEZ CSATLAKOZVA ................................................................................... 4 

Közvetlen fájlnyitás................................................................................................................................................ 4 
Fájlnyitás a PDM részletek megtekintésével.......................................................................................................... 4 
A fájl menü PDM műveletei ................................................................................................................................... 5 
PDM információk a modellfában........................................................................................................................... 6 
Nem aktív munkaterület tartalmának megnézése ................................................................................................... 6 
Munkaterület elérés makróval ............................................................................................................................... 7 
PDM műveletek jobb kattintással........................................................................................................................... 7 
Modell verziók összehasonlítása ............................................................................................................................ 8 
Exportált modell formátumok kezelése .................................................................................................................. 9 
PDM keresési lehetőség Pro/ENGINEER-ben..................................................................................................... 10 

HATÉKONY ADATKEZELÉS PDM KÖRNYEZETBEN..................................................................................................... 11 
Munkaterületen lévő adatok kezelése táblanézetekkel ......................................................................................... 11 
Nem utolsó konfigurációk letöltése ...................................................................................................................... 13 
Baloldali csúszka konfigurálása a munkaterületen.............................................................................................. 13 

HATÉKONYSÁGNÖVELÉS A BÖNGÉSZŐBEN................................................................................................................ 14 
Legutolsó hozzáférések legördülő menüje............................................................................................................ 14 
A vállalati szintű keresés befolyásolása............................................................................................................... 14 
„Fogd és húzd” technika alkalmazása ................................................................................................................ 15 
A beágyazott böngészőfelület maximalizálása ..................................................................................................... 15 
Változásban érintett elemek gyors elérése ........................................................................................................... 16 
HTML hivatkozások rajzokhoz rendelése............................................................................................................. 16 

 
 
 
 
 



UNITIS Rt. PDMLink ügyességek Pro/ENGINEER Wildfire környezetben   3 

Bevezető 
 

A PDM rendszer használata megfelelő modellezési metodikára kényszeríti rá a CAD rendszer felhasználóit. 
Részben ez eredményezte azt, hogy a Pro/ENGINEER Wildfire és a PDMLink/Pro/INTRALINK 8.0 között 
közvetlen kapcsolat alakult ki. Tehát a tervezőnek nincs szüksége egy köztes alkalmazásra, közvetlenül a 
Wildfire beépített böngészőjén keresztül elérheti a PDM rendszerbe töltött adatokat. 

Ez a kis kézikönyv számos tippel és trükkel kívánja segíteni a két alkalmazás együttes használóit.  
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A tervezés megkönnyítése PDMLink-hez csatlakozva 
Közvetlen fájlnyitás 

 

A termékadat kezelő rendszerek előtt a felhasználók többsége a helyi fájl rendszert és a hálózati gépeket 
használta Pro/ENGINEER (Pro/E) adatok tárolására. A keresési útvonal beállítása kritikus volt a komplex 
Pro/E kapcsolatokban szereplő fájlok megtalálásában. A tervezők élvezték azt a lehetőséget, hogy a modellek 
és a rajzok közvetlenül Pro/E-ből összegyűjthetők a neveik megadásával, de ez a módszer a keresési útvonal 
alapján elsőre megtalált fájlokat olvasta be. Ez akkor volt problémás, ha létezett több egyforma nevű fájl, de 
különböző geometriát hordoztak. 

A Pro/INTRALINK megoldotta ezt az integritás problémát, de hozott egy olyan követelményt, hogy a 
modelleket a központi adatbázisból le kellett tölteni a munkaterületre mielőtt a tervező megnyitotta azokat a 
Pro/E-ben. 

A Wildfire és a PDMLink/Pro/INTRALINK 8.0 közötti közvetlen kapcsolat segítségében közvetlenül az 
adatbázisból tölthetők le a fájlok, nem kell külön megadni melyik munkaterülethez kapcsolódunk illetve 
melyik termékben vagy adattárban lettek tárolva a fájlok. 

Ez a funkció azért működik így, mert a PDM adatbázisban egyedinek kell lenni a fájl névnek. A közvetlen 
fájlnyitást alkalmazva a modell automatikusan letöltődik a szükséges kapcsolataival a lokális munkaterületre. 
Miután letöltődött a Pro/E egyből meg is nyitja. 

 

 
 

A közvetlen fájlnyitáshoz válasszuk a File > Open menüt és adjuk meg a teljes fájlnevet a kiterjesztéssel 
együtt, majd kattintsuk az Open gombra. Ezzel a módszerrel egyszerűsített reprezentációt is meg lehet nyitni 
az Open Rep… gombot választva. 

 

Fájlnyitás a PDM részletek megtekintésével 
 

A fájl megnyitás ablakban nem csak a fájl nevét tudjuk megnézni, hanem egyéb PDM információkat is. A 
fájlnéven kívül láthatjuk az azonosító számot, verziót, a módosítás dátumát, az életciklus fázist és a PDM 
nevet. Gyakran a PDM név egy beszédes leíró név, így jóval hasznosabb mint az azonosító szám. 
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A fájl nyitó ablakban kattintsunk a Display Configurations > Details. 

A fájl menü PDM műveletei 
 

A leggyakrabban használt funkciók hozzá lettek rendelve a Pro/E fájl menüjéhez. A Check Out és az Undo 
Checkout a kikölcsönzés és a kikölcsönzés visszavonása műveletek. A visszamentésnek két típusa van: Auto 
és Custom Check In. 

 

 
 

Auto Check In az alapértelmezett beállítások szerint automatikusan az adatbázisba menteni a modelleket. Ha 
első adatbázisba mentésről van szó, akkor modellek bekerülnek a beállításokban megadott helyekre. A 
Windchill alkatrészek nem fognak létrejönni ezzel a módszerrel. 

Custom Check In segítségével egyéb információk is megadhatók. A felhasználó a Pro/E fájlokkal együtt 
feltöltheti a modellekből konvertált ProductView fájlokat. Így nem a szerver oldalon jönnek létre az előnézeti 
képek. Ezt a módszert alkalmazva mentés előtt megjelenik egy ablak, ahol még meg lehet változtatni a 
mappákat (első mentés esetén), pillanatkép hozható létre, létrehozhatók a Windchill alkatrészek, amik a Pro/E 
fájlokat hordozó CAD dokumentumokhoz lesznek kapcsolva. 

Save and Upload segítségével végbemegy egy mentés, valamint a Pro/E fájlok felkerülnek a felhasználó 
szerver oldali munkaterületére. Ezek a fájlok nem lesznek elérhetők a többiek számára csak miután a Check In 
paranccsal bekerültek a mindenki számára elérhető mappákba. Azért hasznos ez a funkció, mert a modellek 
bekerülnek egy biztonságos helyre és ezek a fájlok már elérhetővé válnak az automatikus Windchill alkatrész 
asszociáció parancs előtt. 

Az Update művelet összehasonlítja a Pro/E memóriájában lévő aktuális vagy az összes elemet a PDM 
szerveren lévőkkel. Ha bármelyik fájlt más felhasználó módosította és visszamentette a szerverre, akkor 
megjelenik egy ablak, amiben felsorolásra kerülnek a módosított fájlok és letölttethetők a szerverről. 
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PDM információk a modellfában 
 

Pro/E paraméterek átvihetők a PDM szerverre. Az adatmegjelenítés visszafelé is működik, PDM információk 
is megnézhetők Pro/E-ben. Számos fontos információ, a verzió, életciklus fázis, a lokális adatbázis státusz 
megjeleníthető a modellfában. 

 
 

A modellfában válasszuk a Settings > Tree Columns > Database Params menüt és jelöljük ki a 
megjeleníteni kívánt PDM attribútumokat. 

 

Nem aktív munkaterület tartalmának megnézése 
 

A Pro/E egyszerre csak egy aktív munkaterületet enged használni. A File > Open ablak az aktív munkaterület 
tartalmát mutatja meg. Viszont néha szükség lehet arra, hogy megnézzük más munkaterületek tartalmát is 
anélkül, hogy keressünk a PDM szerveren. Mindezt megtehetjük, ha a mappa navigátorban lenyitjuk a PDM 
szerver ikonját és a kabinetek között kiválasztjuk a Workspaces kabinetet. 
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Ezzel a módszerrel a termékekben és az adattárakban is böngészhetünk közvetlenül a Pro/E-ből 

 

Munkaterület elérés makróval 
 

Az aktív munkaterület megnézése vagy frissítése egy egyszerű művelet, válasszuk ki mappa navigátoron vagy 
az ikonját vagy a listában szereplő csomópontot. Tervezés közben a modellfa aktív, a munkaterület egyszerű 
frissítéséhez célszerű definiálni egy makrót és hozzáadni az eszköztárhoz. Ha a modellfa minimalizálása 
szükséges munka közben, akkor a makró befejezéséig legyen minimalizálva ez a panel. 

A makró rögzítése miközben megnyitottuk a modellt: kattintsunk a Folder Navigator – Aktív munkaterület 
– Modellfa fül – Macro Stop. Majd mentsük el a makrót a config.pro fájlba. 

Nyomógomb hozzárendelése az eszköztárhoz: Tools – Customize Screen – Commands fül kiválasztása – 
Mapkey kategória kijelölése – jelöljük ki az új makrót és húzzuk az eszközsorra. Majd mentsük el a 
config.win fájlt. 

 

 
 

PDM műveletek jobb kattintással 
 

Az alap PDM műveletek a Wildfire fájl menüjéhez van rendelve. Ezek a műveletek a modellfából is elérhetők 
jobb egérgomb kattintással: Check Out, Check In, Undo Check Out, Update. 
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Modell verziók összehasonlítása 
 

A Pro/E lehetővé teszi bármely két modell összehasonlítását építőelem vagy geometria szintjén. PDM rendszer 
segítségével a modell összes verziója tárolható, így lehetőség nyílik egy alkatrész különböző verzióinak 
összehasonlítására. Hasznos lehet ez a funkció például mielőtt egy modell C verzióját D-re emelik és 
elfogadják a változás kérést (ECR) vagy ha régi verziók közti különbségeket szeretnénk visszakeresni. 

Alapértelmezésként a Pro/E a legutolsó verziót tölti le. Ebben a példában a konzol a B.1 verziónál tart. 
Szeretném megnézni, hogy miben változott a geometria az A.1 verzióhoz képest. 

 

 
 

Nyissuk meg azt a modellt, amire az összehasonlítást le szeretnénk futtatni (B.1). Majd Analysis > Compare 
Part >By Feature vagy By Geometry. A megnyitás ablakban navigáljunk el arra a helyre, ahol az egyéb 
verziók vannak tárolva. 

 

 
 

Kattintsunk a megnyitás ablak jobb felső sarkában a  ikonra és válasszuk ki az All Versions opciót. 
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Válasszuk ki az előző verziót (A.1) és a verzió ütközésre figyelmeztető ablakon válasszuk, hogy OK. 

 

 
 

A geometriai összehasonlításnál győződjünk meg, hogy a megfelelő tolerancia érték van-e beállítva és hogy 
csak a különbségek jelennek-e meg. Részletes információkat a Pro/E súgójában a Compare Part Feature 
fejezetben kaphatunk. 

 

Exportált modell formátumok kezelése 
 

Sok esetben a tervezőknek valamilyen exportált formátumokban kell megosztani a Pro/E adatokat: IGES, 
STEP, Shrinkwrap. Miután több formátum is készül a modellről, nehézkessé válhat a verziók követése. 
Valamint arra is szükség lehet, hogy az aktuális verziót osszuk meg vagy esetleg egy kiadott verziót. Jó példa 
lehet, hogy egy neutrális fájlt (IGES) biztosítsunk olyan területeknek, ahol nincs Pro/E. 

A PDMLink modell kezelése lehetővé teszi, hogy ezeket az exportált formátumokat csatolt mellékletként 
tároljuk a modell fájl mellett. A PDMLink-ben van egy szerver oldali tulajdonság, ami nyomon követi, hogy a 
másodlagos tartalom fájl elavult-e a modellhez képest, amikor az elsődleges fájlhoz egy új iteráció jön létre 

codebase\com\ptc\windchill\cadx\cfg\default\contentcat.ini – EXPORT.markoutofdate=true 

Tehát ha beállított egy a tulajdonság, akkor visszamentés esetén egy felülbírálható konfliktus jelentkezik, ha a 
másodlagos tartalon fájl nem frissül. 

 

 
 

A módszer alkalmazása: File > Save a Copy – válasszuk ki a fájl típust (IGES, STEP stb.) és jelöljük be a 
Save new files to model’s CAD document négyzetet. 
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Majd mentsük a modellt az adatbázisba. 

 

 
 

PDM keresési lehetőség Pro/ENGINEER-ben 
 

A PDM adatbázisban tárolt modellek megnyitásának számos módja van. Az egyik gyakran alkalmazott mód a 
keresés segítségével történő megnyitás. A tervezőnek nem kell kilépnie a Wildfire-ből, közvetlen keresési 
lehetőség érhető el. Kereshetünk név, azonosító szám, vagy akár paraméterek szerint is. A keresési 
kritériumokat el lehet menteni és bármikor újra alkalmazhatók. 
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Hatékony adatkezelés PDM környezetben 
Munkaterületen lévő adatok kezelése táblanézetekkel 

 

A hatékonyabb teljesítmény miatt a tervezési munka a lokális munkaterületeken folyik, míg folyamatos a 
kapcsolat a központi szerverrel csoportmunka támogatási okokból. A munkaterületen megjeleníthetők a fájl 
típusok, attribútumok, státuszok. Tervezés során számos információra szükség van, de nem mindig kell látni 
őket. Túl sok fájl megjelenítése hosszú táblázatokat jelent, míg sok attribútum zsúfoltságot. A szerverrel 
történő gyakori kommunikáció pedig lassabb teljesítményt eredményez. 

A munkaterületeken különböző célok miatt számos nézet konfigurációk hozhatók létre. Ha a rendszer 
adminisztrátor definiál ilyen nézeteket, akkor azt az összes felhasználó elérheti. Persze arra is van lehetőség, 
hogy mindenki saját maga számára definiáljon ilyen nézeteket. Tábla nézet létrehozásakor meg kell adni a 
nézet nevét/leírását, a megjelenítendő oszlopok listáját és a szűrési szabályokat. Táblanézetek alkalmazásával a 
munkaterület gyorsabban használhatóvá tehető. 

Hasznos táblanézet ha látjuk a konkurens tervezési státuszokat. Konfigurálható úgy a munkaterület, hogy a 
Compare Status segítségével egyből láthatóak legyenek az elavult fájlok. Ezt az oszlopot azért nem célszerű 
minden nézethez hozzárendelni, mert a szervertől történő folyamatos adatkérés nagy leterheltséget okozhat, 
főleg ha nincs széles sávú kapcsolat a szerverrel. Akkor javasolt az összehasonlító oszlop használata, ha 
egyszerre több tervező dolgozik ugyanazon a modellen és fontos az utolsó módosítások elérése. 

 

 
 

A rendszer mindig meggátolja a nem engedélyezett műveletek használatát, de előfordulhat az is, hogy a 
felhasználó csak akkor értesül a problémáról, ha megpróbálja végrehajtani az adott műveletet. Például, ha a 
munkaterületemen olyan fájl van, amit más kikölcsönzött és olyan táblanézetet használok, ami nem tartalmazza 
a Compare Status oszlopot, akkor nem lesz tudomásom róla. Ha most megpróbálom kikölcsönözni a fájlt, 
akkor kapok egy figyelmeztető üzenetet, hogy ezt nem tudom megtenni. Ezért érdemes egy olyan nézetet 
definiálni, ami tartalmazza az összehasonlító oszlopot és egyből értesülni fogok, ha a másik felhasználó 
visszamentette a fájlt az adatbázisba. Innentől az Update utasítással letölthető a fájl módosítása a 
munkaterületre. 

Ha először szeretnénk fájlokat feltölteni a PDM rendszerbe, akkor tapasztalhatunk olyan esetet, hogy 
hiányoznak szükséges referenciák. Ezeket a hiányzó kapcsolatokat szellem (ghost) objektumként kezeli a 
rendszer. Az ilyen esetek ellenőrzéséhez hozzuk létre az alábbi táblanézetet. A Match All négyzetet ne jelöljük 
be, így minden fájl megjeleni, amelyikre bármely feltétel teljesül. 
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A megjelent fájlnév konfliktus feloldásához, először jelöljük ki azokat az elemeket, amelyiknél névkonfliktus 
jelentkezett és hajtsuk végre az Add to Wotkspace (+) utasítást. A letöltés kezelő ablakban megjelenik egy  
ikon, majd kattintsunk a Next gombra. Válasszuk ki az összes elemet, majd Download és a szerverről le 
fognak töltődni az adott nevű fájlok a munkaterületre, Finish. 

 

 
 

A hiányzó függőség megoldásához az összes fájlt mentsük el és töltsük fel a szerverre, Save and Upload. 
Nyissuk meg a hiányzó fájl tulajdonságlapját a munkaterületről, és válasszuk az Add a Placeholder menüt (ez 
a művelet feltételezi azt, hogy definiáltunk CAD sablont a PDM rendszerben). Majd mentsük az adatbázisba a 
modelleket, Check In. 

Másik hasznos táblanézet, ha a fájl típusokhoz definiálunk nézeteket. Például külön a CAD fájloknak 
(Type=Workgroup Manager CAD Document), Windchill alkatrészeknek (Type=Part), vagy csak rajzok 
számára (File Name=*.drw).  
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Nem utolsó konfigurációk letöltése 
 

A Pro/E fájlok legegyszerűbb letöltési gyakorlata, hogy az utolsó konfiguráció kerül letöltésre. Bizonyos 
esetekben azonban szükség lehet korábbi verziók letöltésére is vagy változtatni kell a letöltött elemek számán, 
mondjuk rajzok, családtáblás elemek hozzáadásával. 

A letöltési ablakban (Add to Workspace) lehetőség van a konfigurációs lista megváltoztatására. 

 

 
 

Baloldali csúszka konfigurálása a munkaterületen 
 

Alapértelmezésként a táblázat függőleges görgetését kezelő csúszka a munkaterület jobboldalán helyezkedik 
el. Ha a munkaterületen sok elem és sok oszlop van, akkor alul is megjelenik egy vízszintes csúszka. Ha a 
lefelé görgetéshez nem szeretnénk használni a vízszintes csúszkát, akkor célszerű azt átrakni a baloldalra. A 
site.xconf fájlhoz adjuk hozzá a következő sort: 

 

<Property name=”com.ptc.core.htmlcomp.jstable.positionScrollbarLeftside” overridable=”true” 
targetFile=”codebase/wt.properties” value=”true”/> 
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Hatékonyságnövelés a böngészőben 
Legutolsó hozzáférések legördülő menüje 

 

A tervezési gyakorlat egyik jellemzője, hogy ugyanazokon a modelleken kell újra és újra dolgozni. Ha ezek az 
elemek a munkaterületen vannak, akkor nagyon egyszerű az elérésük és a módosításuk. Az is gyakori, hogy a 
PDM szerver mappáin belül kell megkeresni a szükséges modelleket. Könyvjelzők segítségével megjelölhetők 
a gyakran szükséges oldalak. 

A PDMLink a HTML oldalak legtetején jeleníti meg a legutóbbi hozzáférések listáját. Az ilyen legördülő 
menük a Kezdőlapon, a Változás lapon és a Termékek/Projektek/Adattárak közti váltás lapján találhatók meg. 

 

 
 

A vállalati szintű keresés befolyásolása 
 

Különböző feladatok ellátó emberek különböző módon tudnak keresni. Aki nem a Pro/E beágyazott keresését 
használja, annak lehetősége van külön böngészőben keresni különböző adatszinteken. 

 

 
 

A vállalati szintű keresés hozzáféréstől függően keres termékben, projektben és adattárban. De lehetőség van 
egy szinttel lejjebb menni és konkrétan egy termékben, projektben vagy adattárban keresni. 

A haladó szintű keresés oldalán keresési feltételek állíthatók össze. Ezek a feltételek elmenthetők és bármikor 
felhasználhatók újra. 

Azok a felhasználóknak, akik a PartsLinket is implementálták, lehetőségük van osztályozó keresést is 
végrehajtani. Így a tárolt elemeket egy logikai hierarchiába lehet sorolni. 



UNITIS Rt. PDMLink ügyességek Pro/ENGINEER Wildfire környezetben   15 

 
 

„Fogd és húzd” technika alkalmazása 
 

A Pro/E tartalom fájl a CAD dokumentum tulajdonságlapján van feltüntetve. Mióta a Wildfire képes az URL-
ket is megérteni, lehetőség van egy URL mögötti tartalmat behúzni a modellező felületre. Mindehhez az 
Internet Explorer böngészőben szükség van egy-két beállítást megadni. Először is a PDM szervernek a 
megbízható helyek közé kell tartoznia. 

 

 
 

A beágyazott böngészőfelület maximalizálása 
 

Ha a Wildfire beágyazott böngészőjében ritkán használjuk a címsort és az eszköztárakat, akkor érdemes 
letiltani őket, mert így közel három centiméterrel növelhető az értékes munkafelület. 

Pro/E-ben válasszuk ki a Tools > Customize Screen > Toolbar Tab menüt. Vegyük ki a jelölést a Browser 
Toolbar és az Address Bar elől. A config.win mentse. 
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Változásban érintett elemek gyors elérése 
 

A PDMLink 8.0 lehetővé teszi, hogy a változás értesítőn kijelöljük mind a CAD dokumentumot, mind a 
Windchill alkatrészt és végrehajtsuk az új verzió létrehozását. Így megmarad a CAD dokumentum és a 
Windchill alkatrész közti megfelelő kapcsolat. 

A Wildfire beépített böngészőjében keressük meg a megfelelő változás értesítőt. Az érintett elemek táblában 
jelöljük be a CAD dokumentumokat és a Windchill alkatrészeket és kattintsunk a Revise ikonra. Az eredmény 
elemek listájából nyissuk meg a CAD dokumentum tulajdonságlapját és a tartalom hivatkozást húzzuk a 
modellező területre. Ekkor elindul a menet közbeni kikölcsönzés. 

 

HTML hivatkozások rajzokhoz rendelése 
 

A rajzon feltüntetett verzió blokk gyakran tartalmazza a változás értesítő azonosítószámát, ami felelős a 
verziók közti váltásért. Ezek a változás értesítők a változási folyamatok futásakor keletkeznek, velük világosan 
nyomon követhető a változáskérések eredményei. 

A megváltoztatott rajz új verzióján létrehozható egy olyan szövegdoboz, ami hivatkozást tartalmaz a rajzhoz 
tartozó változás értesítőhöz. 

Nyissuk meg a változás értesítő tulajdonságlapját és másoljuk ki a vágólapra a böngésző címsorát. A rajz 
szövegdobozában adjuk meg az értesítő azonosítószámát és a Hyperlink gomb értékmezőjébe illesszük be az 
imént kimásolt címet. 

 

 
 

A tulajdonságlap megnyitásához ugorhatunk, ha a rajzon a <Ctrl> billentyű lenyomásával rákattintunk a 
szövegdobozba beírt azonosítószámra. 

 

 
 

 

 


